dsPICDEM™ MCHV-3
Development Board
User’s Guide
Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MicroCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless otherwise stated.

Trademarks
The Microchip name and logo, the Microchip logo, AnyRate, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KeeLoq, KeeLoq logo, Kleer, LANCheck, LINK MD, MediaLB, MOST, MOST logo, MPLAB, OptoLyzer, PIC, PICSTART, PIC32 logo, RightTouch, SpyNIC, SST, SST Logo, SuperFlash and UNI/O are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.
ClockWorks, The Embedded Control Solutions Company, ETHERSYNCH, Hyper Speed Control, HyperLight Load, IntelliMOS, mTouch, Precision Edge, and QUIET-WIRE are registered trademarks of Microchip Technology Incorporated in the U.S.A.
SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.
GestIC is a registered trademarks of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.

© 2016, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.
ISBN: 978-1-5224-0663-1
EU Declaration of Conformity
Object of Declaration: dsPICDEM™ MCHV-3 Development Board

Manufacturer: Microchip Technology Inc.
2355 W. Chandler Blvd.
Chandler, Arizona, 85224-6199
USA

This declaration of conformity is issued by the manufacturer.

The development/evaluation tool is designed to be used for research and development in a laboratory environment. This development/evaluation tool is not intended to be a finished appliance, nor is it intended for incorporation into finished appliances that are made commercially available as single functional units to end users. This development/evaluation tool complies with EU EMC Directive 2004/108/EC and as supported by the European Commission’s Guide for the EMC Directive 2004/108/EC (8th February 2010).

This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU.

This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in compliance with the essential requirement and other relevant provisions of the R&TTE Directive 1999/5/EC and the FCC rules as stated in the declaration of conformity provided in the module datasheet and the module product page available at www.microchip.com.

For information regarding the exclusive, limited warranties applicable to Microchip products, please see Microchip’s standard terms and conditions of sale, which are printed on our sales documentation and available at www.microchip.com.

Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA

Derek Carlson
VP Development Tools

12- Sep -14
Date
Safety Notice

To avoid a safety hazard, the safety notices and operating instructions provided should be adhered to. If in any doubt, consult your supplier.

WARNING – This system must be earthed (grounded) at all times.

WARNING – The output terminals are NOT isolated from the incoming AC mains supply and may be at up to 410V with respect to ground, regardless of the input mains supply voltage applied. These terminals are live during operation AND for five minutes after disconnection from the supply. Do not attempt to access the terminals or remove the cover during this time.

WARNING – The unit may obtain power through the output terminals if these are connected to a rotating motor acting as a generator. If this is the case, then the previous warning also applies (i.e., the output terminals are live when connected to the generator and for five minutes after the generator has been stopped). Note that this case can arise even when the unit has been disconnected from the incoming AC mains supply.

CAUTION – The system should not be installed, operated, serviced or modified except by qualified personnel who understand the danger of electric shock hazards and have read and understood the user instructions. Any service or modification performed by the user is done at the user’s own risk and voids all warranties.

CAUTION – If a motor is connected to the output of this unit, the frame should be connected to the output protective ground terminal provided. Particular care should be taken to mechanically guard such a motor, bearing in mind that unexpected behavior is likely to result from the process of code development.

CAUTION – For continued protection against the risk of fire, replace the fuse with one of the same type only (i.e., Fast Act Fuse 15A/250V).

• The system is intended for evaluation and development purposes, and should only be operated in a normal laboratory environment, as defined by IEC 61010-1:2001.
• Clean with a dry cloth only.
• Operate flat on a bench; do not move during operation and do not block the ventilation holes.
• The system should not be operated without all the supplied covers fully secured in place.
• The system should not be connected or operated if there is any apparent damage to the unit.
• The unit is designed to be connected to the AC mains supply via a standard non-locking plug. As the unit has no mains switch, this plug constitutes the means of disconnection from the supply, and thus, the user must have unobstructed access to this plug during operation.
Table of Contents

Safety Notice ................................................................................................................. 5
Preface ........................................................................................................................... 9

Chapter 1. Introduction
  1.1 Overview ...................................................................................................... 15
  1.2 Features ....................................................................................................... 18

Chapter 2. Getting Started
  2.1 Board Components ...................................................................................... 19
  2.2 User Interface ............................................................................................... 20
  2.3 Connecting the System ................................................................................ 22
  2.4 Power Sequences ........................................................................................ 26

Chapter 3. Hardware
  3.1 Power Factor Correction (PFC) Stage Board ............................................... 31
  3.2 Power Module Stage .................................................................................... 37
  3.3 Electrical Specifications ................................................................................ 47

Appendix A. Board Layout and Schematics.............................................................. 49
  A.1 Introduction .................................................................................................. 49
  A.2 Board Schematics and Layout ..................................................................... 49

Index ............................................................................................................................. 65
Worldwide Sales and Service .................................................................................... 68
Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs and/
or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This preface contains general information that will be useful to know before using the
dsPICDEM™ MCHV-3 Development Board. Topics discussed in this preface include:
• Document Layout
• Conventions Used in this Guide
• Warranty Registration
• Recommended Reading
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT

This user’s guide describes how to use the dsPICDEM™ MCHV-3 Development
Board. The document is organized as follows:
• Chapter 1. “Introduction” – This chapter introduces the dsPICDEM™ MCHV-3
Development Board and provides a brief overview of its features.
• Chapter 2. “Getting Started” – This chapter provides information on getting
started with the dsPICDEM™ MCHV-3 Development Board.
• Chapter 3. “Hardware” – This chapter describes the hardware on the
dsPICDEM™ MCHV-3 Development Board.
• Appendix A. “Board Layout and Schematics” – This appendix provides
diagrams of the hardware layout, as well as schematic diagrams for the
dsPICDEM™ MCHV-3 Development Board.
CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

<table>
<thead>
<tr>
<th>DOCUMENTATION CONVENTIONS</th>
<th>Description</th>
<th>Represents</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial font:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italic characters</td>
<td>Referenced books</td>
<td>MPLAB® IDE User’s Guide</td>
<td>...is the only compiler...</td>
</tr>
<tr>
<td></td>
<td>Emphasized text</td>
<td>the Output window</td>
<td></td>
</tr>
<tr>
<td>Initial caps</td>
<td>A window</td>
<td>select Enable Programmer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the Settings dialog</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quotes</td>
<td>A field name in a window or dialog</td>
<td>“Save project before build”</td>
<td></td>
</tr>
<tr>
<td>Underlined, italic text with right angle bracket</td>
<td>A menu path</td>
<td>File&gt;Save</td>
<td></td>
</tr>
<tr>
<td>Bold characters</td>
<td>A dialog button</td>
<td>Click OK</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A tab</td>
<td>Click the Power tab</td>
<td></td>
</tr>
<tr>
<td>N’Rnnnn</td>
<td>A number in verilog format, where N is the total number of digits, R is the radix and n is a digit.</td>
<td>4'b0010, 2'hF1</td>
<td></td>
</tr>
<tr>
<td>Text in angle brackets &lt; &gt;</td>
<td>A key on the keyboard</td>
<td>Press &lt;Enter&gt;, &lt;F1&gt;</td>
<td></td>
</tr>
<tr>
<td>Courier New font:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plain Courier New</td>
<td>Sample source code</td>
<td>#define START</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Filenames</td>
<td>autoexec.bat</td>
<td></td>
</tr>
<tr>
<td></td>
<td>File paths</td>
<td>c:\mcc18\h</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Keywords</td>
<td>_asm, _endasm, static</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Command-line options</td>
<td>-Opa+, -Opa-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bit values</td>
<td>0, 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Constants</td>
<td>0xFF, ‘A’</td>
<td></td>
</tr>
<tr>
<td>Italic Courier New</td>
<td>A variable argument</td>
<td>file.o, where file can be any valid filename</td>
<td></td>
</tr>
<tr>
<td>Square brackets [ ]</td>
<td>Optional arguments</td>
<td>mcc18 [options] file [options]</td>
<td></td>
</tr>
<tr>
<td>Curly braces and pipe character: {</td>
<td>Choice of mutually exclusive arguments; an OR selection</td>
<td>errorlevel {0</td>
<td>1}</td>
</tr>
<tr>
<td>Ellipses...</td>
<td>Replaces repeated text</td>
<td>var_name [, var_name...]</td>
<td></td>
</tr>
<tr>
<td>Represents code supplied by user</td>
<td>void main (void) { ... }</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. Sending in the Warranty Registration Card entitles users to receive new product updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user’s guide describes how to use the dsPICDEM™ MCHV-3 Development Board. The device-specific data sheets contain current information on programming the specific microcontroller or Digital Signal Controller (DSC) devices. Other useful documents are listed below. The following Microchip documents are available and recommended as supplemental reference resources:

MPLAB® XC16 C Compiler User’s Guide (DS50002071)
This user’s guide describes how to use the 16-bit MPLAB® XC16 C compiler. Please visit www.microchip.com/compilers for more information.

MPLAB® IDE User’s Guide with MPLAB Editor and MPLAB SIM (DS51519)
This user’s guide describes how to set up the MPLAB® IDE software and use it to create projects and program devices.

MPLAB® X IDE User’s Guide (DS50002027)
This document describes how to set up the MPLAB® X IDE software and use it to create projects and program devices.

MPLAB® XC16 Assembler, Linker and Utilities User’s Guide (DS50002106)
This user’s guide describes how to use GNU language tools to write code for 16-bit applications.

Readme Files
For the latest information on using other tools, read the tool-specific Readme files in the Readme subdirectory of the MPLAB® IDE installation directory. The Readme files contain updated information and known issues that may not be included in this user’s guide.

dsPIC33EP256MC506 Plug-In Module (PIM) Information Sheet for Internal Op Amp Configuration (DS52062)
This document provides device-specific information for the dsPIC33EP256MC506 internal op amp configuration PIM.
To obtain any of these documents, visit the Microchip web site at www.microchip.com.
Microchip provides online support via our web site at www.microchip.com. This web site is used as a means to make files and information easily available to customers. Accessible by using your favorite Internet browser, the web site contains the following information:

- **Product Support** – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
- **General Technical Support** – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip consultant program member listing
- **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.

To register, access the Microchip web site at www.microchip.com, click on Customer Change Notification and follow the registration instructions.

The Development Systems product group categories are:

- **Compilers** – The latest information on Microchip C compilers and other language tools. These include the MPLAB® C compiler; MPASM™ and MPLAB 16-bit assemblers; MPLINK™ and MPLAB 16-bit object linkers; and MPLIB™ and MPLAB 16-bit object librarians.
- **Emulators** – The latest information on the Microchip MPLAB REAL ICE™ in-circuit emulator.
- **In-Circuit Debuggers** – The latest information on the Microchip in-circuit debugger, MPLAB ICD 3.
- **MPLAB IDE** – The latest information on Microchip MPLAB IDE, the Windows® Integrated Development Environment for development systems tools. This list is focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager, and general editing and debugging features.
- **Programmers** – The latest information on Microchip programmers. These include the MPLAB PM3 device programmer and the PICkit™ 3 development programmers.
CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or FAE for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY

Revision A (June 2016)

This is the initial released version of the document.
Chapter 1. Introduction

1.1 OVERVIEW

The Microchip dsPICDEM™ MCHV-3 Development Board is intended to aid the user in the rapid evaluation and development of a wide variety of motor control applications using PIC32 and PIC24 Microcontrollers (MCUs), and dsPIC® Digital Signal Controllers (DSCs). This development system is targeted to control Brushless DC (BLDC) motors, Permanent Magnet Synchronous Motors (PMSM) and AC Induction Motors (ACIM) in sensor or sensorless operation.

This flexible and cost-effective tool can be configured in different ways for use with Microchip’s specialized motor control devices. The dsPICDEM™ MCHV-3 Development Board is essentially an upgraded version of the dsPICDEM MCHV Development System. The dsPICDEM™ MCHV-3 Development Board is designed to support the PIC24F, PIC24E, dsPIC33F, dsPIC33E and PIC32 Motor Control device families, and offers a mounting option to connect a generic 100-pin Plug-In Module (PIM).

The system has a three-phase power module device that contains the motor inverter and the gate driver’s circuitry. The circuit drives a BLDC, PMSM or ACIM motor using different control techniques without requiring any additional hardware. It also has Power Factor Correction (PFC) circuitry in order to provide a full set of tools used in motor control applications. Figure 1-1 provides a photograph of the dsPICDEM MCHV-3. A block diagram that shows the main components of the system is provided in Figure 1-2.

The rated continuous output current from the inverter is 6.5A (RMS). This allows up to approximately 2 kVA output when running from a 208V to 230V single-phase input voltage in a maximum 30°C (85°F) ambient temperature environment. Therefore, the system is ideally suited for running a standard 3-phase induction motor of up to a 1 kW (1.34 HP) rating or a slightly higher rated industrial servo motor. The power module is capable of driving other types of motors and electrical loads that do not exceed the maximum power limit, and are predominantly inductive. Furthermore, single-phase loads can be driven using one or two of the inverter outputs.

The unit is capable of operating from 90V, up to a maximum of 265V. A more detailed explanation of power limitations is provided in Chapter 3. “Hardware”.

Note: It is recommended to carefully read Chapter 3. “Hardware” before attempting to use the system.
FIGURE 1-1:  dsPICDEM™ MCHV-3 DEVELOPMENT BOARD

dsPICDEM™ MCHV-3 Development Board
(Part # DM330023-3)
FIGURE 1-2: SYSTEM BLOCK DIAGRAM

PFC Stage Board
- VAC Voltage Feedback
- VAC Zero Crossing
- PFC Current Feedback Circuitry
- Rectifier
- EMI Choke, In-Rush Current Protection, Fuse
- 3.3 VA-3.3V
- 15V PSU
- Relay Circuit

Power Module Board
- Non-Isolated ICSP™ Connector
- dsPIC® DSC or PIC24 MCU
- Voltage Feedback Circuitry (Vbus and Motor)
- Hall Sensors Circuitry
- Current Feedback Circuitry
- Fault Circuitry
- Matrix Board
- Alternative 3.3V/3.3V
- Alternative 15V PSU
- RS-232/USB
- Starter Kit on Board
- POT, PB, RESET

Isolated User Interface
- External Programmer/ Debugger
- RX
- TX
- ICSP Commands
- User Interface

PFC Stage Board Power Module Board
- Vbus
- PFC PWM
- PFC Feedback Signals
- 15V, 3.3V, A-3.3V
- 90V-265V
- Rectifier
- In-Rush Current Protection, Fuse
1.2 FEATURES

This section provides some of the key features of the dsPICDEM MCHV-3 Development Board.

1.2.1 Motor Control Interfaces:
• Three-phase inverter bridge with a power rating of 400V/6.5A (J17)
• Hall sensors/Quadrature Encoder Interface (QEI) for sensored motor control algorithms (J9)
• Phase voltage feedback for sensorless BLDC operation
• DC bus current sense resistor for single shunt vector control
• Phase current sense resistor for dual shunt vector control
• Overcurrent protection
• Support for Microchip MCUs/dsPIC DSCs with internal op amps and comparators

1.2.2 Input/Output:
• One isolated push button (S1)
• Isolated Reset push button (RESET)
• Isolated 10 kΩ potentiometer (POT1)
• LED indicators for PWM outputs
• Two LED indicators for debugging purposes (D2 and D19)

1.2.3 Isolated Communication Ports:
• UART communication via USB (J6)
• UART communication via RS-232 (J8)

1.2.4 Built-in Isolated Programmer/Debugger (J20):
• Starter Kit on-board programmer/debugger (daughter board)

1.2.5 Power Factor Corrector:
• Maximum input voltage: 90 VAC to 265 VAC
• Current feedback circuitry
• VAC input voltage sensing
• Zero-crossing detection
• DC bus sensing
• Overcurrent protection (the maximum power available is specified in Section 3.3 “Electrical Specifications”)

1.2.6 Built-in Power Supplies:
• 15V power supply, maximum power available: 11W
• 3.3V power supply, maximum power available: 2W

1.2.7 Relay Circuit:
• In parallel with inrush current limiter
• Turns on after inrush current minimizes

1.2.8 Additional Protection Circuitry:
• 250 VAC/15A fuse
• Inrush current limiter
• EMI filter
Chapter 2. Getting Started

2.1 BOARD COMPONENTS

The dsPICDEM™ MCHV-3 Development Board consists of two stages:

- PFC Stage
  The first stage is integrated by the Power Factor Correction (PFC) circuitry, the full-bridge rectifier, the 15V power supply, the 3.3V power supply and the relay circuit.

- Power Module Stage
  The second stage is the Power Module Board. This board contains the PIM connector, the isolated user interface connectors and the motor drive.

Figure 2-1 shows an interior view.

FIGURE 2-1: dsPICDEM™ MCHV-3 DEVELOPMENT BOARD ENCLOSURE VIEW
2.2 USER INTERFACE

The dsPICDEM MCHV-3 has the following components to interact with the user. Figure 2-2 shows a photograph of the front of the system.

• Input/Output Control Switches (Figure 2-2):
  - One isolated push button (S1)
  - Isolated Reset push button (RESET)
  - Isolated 10 kΩ potentiometer (POT1)
  - LED indicators for PWM outputs
  - Two LED indicators for debugging purposes (D2 and D19 on the Power Module Board; not shown in Figure 2-2)

• PWM Outputs (Figure 2-2):
  - Enable and disable jumpers (J7)

• Isolated Communication Ports (Figure 2-2):
  - UART communication via USB (J6)
  - UART communication via RS-232 (J8)
  - Communication ports selector (J2, J3)

• Built-in Isolated Programmer/Debugger (Figure 2-2):
  - Starter kit type programmer/debugger (J20)

• Motor Connectors (Figure 2-4):
  - Three-phase inverter bridge connector with a power rating of 400V/6.5A (J17)
  - Hall sensors/Quadrature Encoder Interface (QEI) for sensored motor control algorithms (J9)
  - Ground terminal with a power rating of 300V/30A

• Power Supply Connector (Figure 2-3):
  - AC power inlet specified for 250 VAC/10 amps max (J1)

---

FIGURE 2-2: dsPICDEM™ MCHV-3 DEVELOPMENT BOARD (FRONT)
FIGURE 2-3: dsPICDEM™ MCHV-3 DEVELOPMENT BOARD (LEFT SIDE)

FIGURE 2-4: dsPICDEM™ MCHV-3 DEVELOPMENT BOARD (RIGHT SIDE)
2.3 CONNECTING THE SYSTEM

2.3.1 Power Connections

It is recommended that cables used for the power connections should be terminated with blue or red insulated crimp terminals. If crimp terminals are not used, care should be taken to ensure that stray strands of wire do not short to adjacent terminals or the enclosure. If possible, all wires should be stripped and tinned with solder before connecting to the dsPICDEM™ MCHV-3 Development Board terminals.

For the AC mains supply input, standard double-insulated, 3-core flex cable should be used with a minimum current rating of 10A (1 mm² 18 AWG). A computer power cable can be used.

**Note:** The system is designed for Installation Category II. Therefore, the incoming mains cable should be wired into a standard non-locking 2-pin, in addition with an earth ground type plug.

The recommended output cable size is 1.0 to 1.5 mm² (18 AWG to 16 AWG) and it should have a 600V rating. This cable should also be double-insulated or have a protective ground screen. Access to the terminal screws is provided via holes in the lid of the enclosure. A slotted screwdriver should be used.

**Note:** The user should only access the power terminals when the system is fully discharged (see the “Safety Notice” section on page 5).
Figure 2-7 provides the locations of all connectors. Corresponding tables that describe each connection are provided in the relevant section.

The power connections are listed in Table 2-1.

**TABLE 2-1: POWER CONNECTIONS**

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Neutral</td>
<td>Input</td>
</tr>
<tr>
<td>2</td>
<td>Earth Ground</td>
<td>Input</td>
</tr>
<tr>
<td>3</td>
<td>Live (Fused)</td>
<td>Input</td>
</tr>
<tr>
<td>4</td>
<td>Motor Phase 1 (M1)</td>
<td>Output</td>
</tr>
<tr>
<td>5</td>
<td>Motor Phase 2 (M2)</td>
<td>Output</td>
</tr>
<tr>
<td>6</td>
<td>Motor Phase 3 (M3)</td>
<td>Output</td>
</tr>
<tr>
<td>7</td>
<td>Hall Sensor A (HA)</td>
<td>Input</td>
</tr>
<tr>
<td>8</td>
<td>Hall Sensor B (HB)</td>
<td>Input</td>
</tr>
<tr>
<td>9</td>
<td>Hall Sensor C (HC)</td>
<td>Input</td>
</tr>
<tr>
<td>10</td>
<td>Hall Sensors, 5V Power Supply Terminal</td>
<td>Output</td>
</tr>
<tr>
<td>11</td>
<td>Hall Sensors, Ground Terminal</td>
<td>Output</td>
</tr>
<tr>
<td>12</td>
<td>Motor Ground Terminal</td>
<td>Input</td>
</tr>
</tbody>
</table>
2.3.2 Host/Communication Connections

A mini-USB to USB certified cable or a standard DB9 male-to-female cable should be used to connect the dsPICDEM™ MCHV-3 Development Board to the host computer. The communication port connectors are listed in Table 2-2. Refer to Figure 2-5 for their exact location.

**TABLE 2-2: I/O CONNECTORS**

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>USB to UART Connector</td>
<td>Input/Output</td>
</tr>
<tr>
<td>14</td>
<td>RS-232 to UART Connector</td>
<td>Input/Output</td>
</tr>
<tr>
<td>15</td>
<td>USB Connector for the Starter Kit on the Board Programmer/Debugger</td>
<td>Input/Output</td>
</tr>
<tr>
<td>16</td>
<td>Non-Isolated ICSP™ Connector for Device Programming/Debugging</td>
<td>Input/Output</td>
</tr>
<tr>
<td>17</td>
<td>Matrix Board</td>
<td>Input/Output</td>
</tr>
</tbody>
</table>

2.3.3 Connection Sequence

The recommended connection sequence is listed below. The user should ensure that the following sequence is met before connecting the system to the mains, the motor and the host computer.

1. Connect the motor terminals, R, Y and B (also known as RWB, or 123 or ABC), to the connection nodes, M1, M2 and M3 (4, 5 and 6 in Figure 2-5), respectively, and connect the motor ground to the ground terminal provided on the board chassis.

2. Follow the next steps if position sensors are utilized to control the motor. If not, proceed to Step 3.
   a) If the motor position is sensed with Hall sensors, connect the Terminals A, B and C to the connection nodes, HA, HB and HC (7, 8 and 9 in Figure 2-5), respectively. Also, connect the positive terminal +5V to the connection node, +5V, and the ground terminal to the connection node, GND (10 and 11 in Figure 2-5).
   b) If the motor position is sensed with a Quadrature Encoder Interface, connect the terminals, Phase A, Phase B and index, to the connection nodes, HA, HB and HC (7, 8 and 9 in Figure 2-5), respectively.

3. Connect the communication ports.
   a) If RS-232 communication is used, connect the DB9 male connector to the RS-232 port. Connect the other end to the host PC (12 in Figure 2-5).
   b) If USB communication is used, connect the mini-USB male terminal to the mini-USB female connector, labeled “USB” (12 in Figure 2-5). Connect the other end to the host PC.

*Note:* Before making any connection, verify that the system is not powered and it is fully discharged. The system is completely discharged when the red D13 LED is off.

*Note:* The Microchip serial emulator driver (mchpcdc.inf) should be installed on your PC in order to activate the USB-to-serial emulator. The emulator can be obtained from the dsPICDEM™ MCHV-3 Development Board product page: [http://www.microchip.com/mchv3](http://www.microchip.com/mchv3)
4. Connect the USB cable to the mini-USB female connector, labeled “Program/Debug” (14 in Figure 2-5). Connect the USB male terminal to the USB ports of the host PC.

**Note:** The built-in programmer/debugger is supported in MPLAB® X IDE.

5. Ensure that the appropriate matrix board is plugged into the connector, labeled J4, and that the board is oriented so that its pins are correctly lined up, as shown in Figure 2-6. Refer to Section 3.2.5 “Matrix Board” for more information regarding the matrix board.

**FIGURE 2-6: MATRIX BOARD CONNECTION**

6. Power cord connection. Make sure the power cord is disconnected from the AC mains before connecting the female terminal of the power cable to the AC input connector (1, 2 and 3 in Figure 2-5) of the dsPICDEM™ MCHV-3 Development Board.

**Note:** The unit is designed to be connected to the AC mains supply via a standard non-locking plug. As the unit has no mains switch, this plug constitutes the means of disconnection from the supply. Therefore, the user must have unobstructed access to this plug during operation.
2.4 POWER SEQUENCES

The user should ensure that the following power sequences are adhered to.

2.4.1 Power-up Sequence

The unit is powered up when the power cable is connected to the AC mains. To verify that the unit is powered, make sure that the LEDs D6, D13, D17 and D18 are on.

Note: The unit is designed to be connected to the AC mains supply via a standard non-locking plug. As the unit has no mains switch, this plug constitutes the means of disconnection from the supply and thus, the user must have unobstructed access to this plug during operation.

2.4.2 Power-Down Sequence

1. Stop firing all power devices by removing the PWM OUTPUTS shunt jumper.
2. Turn off the incoming AC supply by disconnecting the power cord from the mains.
3. Wait until the red DC bus LED indicator (D13), located next to the DC bus connector, is no longer illuminated (this will take 5 minutes or less).

2.4.3 Programming/Debugging an Application Code Using the Built-in Starter Kit on the Board Programmer/Debugger

The MPLAB® Starter Kit on-board programmer/debugger for the dsPICDEM™ MCHV-3 Development Board may be used with MPLAB X IDE, the free Integrated Development Environment, which is available from Microchip’s web site (www.microchip.com). MPLAB X IDE allows the Starter Kit on the board to be used as an in-circuit debugger, as well as a programmer.

In-circuit debugging allows you to run, examine and modify your program using the Starter Kit on-board hardware. This greatly assists you in debugging your firmware and hardware together.

Special Starter Kit on-board software interacts with the MPLAB X IDE application to run, stop and single step through programs. Breakpoints can be set and the processor can be reset. Once the processor is stopped, the register’s contents can be examined and modified.

2.4.4 Setting Up an Application for Debug

To prepare the application for debug:

1. Launch MPLAB X IDE and then open the application project. The related workspace will be open. For information on projects and workspaces, refer to the MPLAB X IDE documentation listed in the “Recommended Reading” section of the “Preface” in this user’s guide.
2. In the toolbar, click Debug Project. The build progress will be visible in the Build tab of the Output window.
3. Once the build sequence is complete, MPLAB X IDE will program the target device and begin executing the application code in Debug mode, as shown in Figure 2-7.
FIGURE 2-7: MPLAB® X IDE WORKSPACE
2.4.4.1 RUNNING THE APPLICATION IN DEBUG MODE

The Starter Kit on the board executes the application code in either real-time (Continue) or steps (Step Into, Step Over, Run to Cursor, and Set PC at Cursor). Real-time execution occurs when you select Continue in MPLAB X IDE. Once the device code is halted, either by clicking Pause or by a breakpoint, you can step.

| Note: When Pause is clicked to stop the program execution, all of the peripherals are frozen. |

To see how these options function, do the following:

1. Select Debug>Reset or click the Reset icon to reset the program.
2. Select Debug>Continue or click the Continue icon. Observe how the application operates.
3. Select Debug>Pause or click the Pause icon to stop program execution. A green solid arrow will mark the line of code in the File window where the program halted.
4. Select Debug>Step Into or click the Step Into icon to step the program execution once. The green solid arrow will move down one line of code in the File window. Repeatedly click the button to step through the code.
5. Select Debug>Reset OR click the Reset icon to reset the program again.
6. Select Debug>Finish Debug Session or click the Finish Debug Session icon to exit Debug mode.
2.4.4.2 DEBUGGING THE APPLICATION

MPLAB X IDE provides an editor and several debug features, such as breakpoints and Watch windows to aid in application code debugging.

2.4.4.2.1 Editing Application Code

To view application code so it may be edited, do one of the following:

Select *File > Open File* to search for and open an existing code file or double click a file in the Project window to open an existing code file. See an example Project window in Figure 2-8.

FIGURE 2-8: PROJECT EXAMPLE

[Diagram showing project window with various files and folders, including "PMSM.c", "initdspic.c", and "smc.s".]

Existing Code

For more information on using MPLAB X IDE to create and edit code, see the MPLAB X IDE Help.
2.4.5 Programming an Application

When the program is successfully debugged and running, the next step is to program the device for stand-alone operation in the finished design. When doing this, the resources reserved for debug are released for use by the application. To program the application, use the following steps:

1. Select Debug>Finish Debug Session or click the Finish Debug Session icon to exit Debug mode.
2. Select Run>Run Project or click the Run Project icon to build the application, program the device and release it from Reset. Alternatively, click the Make and Program Device icon to build the application and program the device (this action does not release the device from Reset).

At this point, the application code will run independently.

2.4.6 Determining Device Support and Reserved Resources

Due to the built-in in-circuit debugging capability of MPLAB ICD 3 devices, and the In-Circuit Serial Programming™ (ICSP™) function offered by the debugger, the Starter Kit on the board uses some on-chip resources when debugging. It also uses program memory and file register locations in the target device during debugging. These locations are not available for use by user code. In MPLAB X IDE, registers marked with an “R” in the register display represent reserved registers.

2.4.7 Troubleshooting

2.4.7.1 DEBUG CONNECTION PROBLEMS

While using the Starter Kit on the board as a debugger, you may receive the error, “Starter Kits (PKOB) not found”, when programming the device. This can result from communication being lost between the Starter Kit on the board and MPLAB X IDE. To resolve this:

1. Unplug the USB cable from the Starter Kit.
2. Plug the USB cable back into the Starter Kit.

MPLAB X IDE should automatically reconnect to the Starter Kit on the board and display its Serial Number (SN) in the same dialog box. Click the serial number, followed by OK to continue. If this does not work, do the following:

1. Check the USB connection between the PC and Starter Kit at both ends.
2. If using a USB hub, make sure it is powered.
3. Make sure the USB port is not in use by another device.

2.4.7.2 PROGRAMMING PROBLEMS

If, during the course of developing your own application, you can no longer program the device, you may have set device Configuration bits to code-protect or some other state that prevents programming. To view the settings of the Configuration bits, select Window>PIC Memory Views>Configuration bits.

2.4.8 Starter Kit On-Board Information Tab

The firmware version and Operating System (OS) version of the Starter Kit on the board can be obtained from the Project Dashboard window of MPLAB X IDE. The Project Dashboard window also displays other useful information, such as the Starter Kit on-board Vdd, target Device ID and target Device ID revision.
Chapter 3. Hardware

This chapter describes the hardware components of the dsPICDEM™ MCHV-3 Development Board.
Topics covered include:

- Power Factor Correction (PFC) Stage Board
- Power Module Stage
- Electrical Specifications

3.1 POWER FACTOR CORRECTION (PFC) STAGE BOARD

This board has two main functions: the first one is to provide the required power supplies to the Power Module Stage Board; the second function is to create the power bus rail that will be used to energize the motor through the power module.

Note: The circuits for the hardware described in this section are shown in Appendix A. “Board Layout and Schematics”.

3.1.1 AC Supply Input

The AC supply input stage of the board consists of the following components:

- F1 – 15A/250 VAC fast acting fuse (only replace with a part of the same rating).
- C1, C2 – Film capacitors to aid in the suppression of AC supply transients, and to also provide a low-impedance return path for any currents that flow from the power device tabs to the heat sink and enclosure due to capacitive coupling.
- C3 – Film capacitor to aid in the suppression of AC supply transients.
- R1 – A metal oxide varistor located across the incoming supply lines to suppress high-energy transients.
- L1 – 2.3 mH/15A choke inductor for suppressing EMI.
- C4 – Film capacitor to aid in the suppression of EMI.
- C5, C6 – Film capacitors to aid in the suppression of AC supply transients, and to also provide a low-impedance return path for any currents that flow from the power device tabs to the heat sink and enclosure due to capacitive coupling.
- R7 – A 1W high-voltage resistor, which acts to discharge C4.
- R6 – A resistor with a negative temperature coefficient that acts to limit the surge of input current that would occur at initial application of power due to the discharged DC bus capacitance. The initial nominal cold resistance is 1 Ohm, which reduces once current flows and the device heats up.
- BR1 – A single-phase bridge rectifier to convert the incoming AC into DC suitable for input to the power conditioning stage.
- K1 – Relay which comes into operation after the inrush current dies out.
- R76, R77 – These are the voltage divider resistor outputs, which are connected to the gate input of the MOSFET.
- C25 – This is used as a charging capacitor to introduce delay before turning on the MOSFET.
- U9 – MOSFET is used to turn on the relay, K1.
- D15 – Diode is used to avoid premature turn-on of the MOSFET.
3.1.2 Active Power Factor Correction (PFC)

The active PFC circuit is essentially a simple boost chopper with the control aimed at shaping the input current to follow the incoming mains supply waveform. The purpose of the different parts of the circuit is described below.

- **L6** – A high-frequency axial inductor with a single layer winding on a ferrite core. This component is in-series with the main inductor (L7) to reduce the effect of the self-capacitance of its winding. Without L6, significant high-frequency (15 MHz) ringing of the inductor current occurs at every transistor turn-on, which would increase EMI and the PFC transistor switching loss.

- **L7** – A power inductor with three stacked toroidal cores, made from a powdered iron material, to limit the core loss while maintaining good energy storage density. The particular cores used are Magnetics 0077083A7. A simple multilayer winding is used, which results in moderate copper loss, but significant self-capacitance. Sixty-six turns of a 1.5 mm diameter enameled copper wire is used. The design offers a good compromise between cost, core loss and size for this application. The nominal inductance is 1 mH at 10A.

- **Q2** – A 600V TO-247 IGBT. As the tab of the device is not isolated, a thermally conductive insulator is used. When closed, Q2 increases the energy stored in the inductor, L7. When open, energy stored in the inductance is transferred to the DC bus capacitors (C30-C32). Energy is also drawn from the AC supply during this time. By appropriate control of the switches, the input current waveform can be profiled to obtain good power factor and low harmonic distortion.

- **D12** – A 600V TO-247 diode optimized for use at high switching frequency. As the tab of the device is not isolated, a thermally conductive insulator is used.

- **C28, R31, R32, R33, D11** – A “snubber” that acts to dampen high-frequency oscillations and limit the rate of change of voltage across Q2.

- **C30, C31, C32** – 470 µF/450V electrolytic capacitors, which act as the main DC bus energy storage capacitors.

- **U6** – The MCP14E4 device is made up of 4.0A buffers/MOSFET drivers and dual non-inverting, enable inputs. It is capable of operating from a 4.5V to 18V single power supply, and can easily charge and discharge a 2200 pF gate capacitance in under 15 ns (typical). It provides low-impedance in both the ON and OFF states to ensure the MOSFET’s intended state will not be affected, even by large transients. The MCP14E4 inputs may be driven directly from either the TTL or CMOS (2.4V to 18V). It is an ideal choice for this application, allowing up to 4A of peak gate drive current to switch Q2 rapidly and therefore, achieve low switching loss. It also has a small footprint, allowing it to be located physically close to the transistors, allowing a low-inductance gate circuit layout.

- **R90, R94, R101** – These resistors are used to pull down the corresponding input/output pins of the gate driver.

- **D9, C26, C27** – Inductance of the power tracking between the source of Q2, due to the physical board layout, means there is a substantial transient voltage between the +15V supply point reference at R28 and the source of Q2. This simple, low-cost circuit allows the power supply of U19 to move transiently.

- **R75, R29 and D10** – These components control the current and voltage to turn on and turn off the IGBT. R29 controls the rising time and the di/dt when the IGBT is turned ON. R29, in parallel with R75, controls the falling time and the di/dt when the IGBT is turned off.
3.1.3  PFC Feedback Circuitry

In a digitally controlled PFC, the relevant analog parameters and control loops need to be redefined and discretized. This enables changeover from existing hardware, to its digital counterpart, easier and more logical.

The PFC is an AC-to-DC Converter, which converts the AC input voltage to a DC voltage and maintains sinusoidal input current at a high input power factor. In a digitally controlled PFC, three inputs signals are required to implement the current control.

The input rectifier (BR1) converts (shown in Section 3.1.1 “AC Supply Input”) the alternating voltage at power frequency into a unidirectional voltage. This rectified voltage is fed to the chopper circuit to produce a smooth and constant DC output voltage to the load. The chopper circuit is controlled by the PWM switching pulses, generated by the Microchip PIC® MCU/dsPIC® DSC devices, based on four measured feedback signals:

• Rectified input voltage
• AC input voltage zero-crossing event
• Rectified input current
• DC bus voltage

The rectified input voltage is measured in two stages:

• Signal conditioning: R22, R23, R24, R25, C24 and D7 convert and filter the AC input voltage waveform, from 90-265 VAC to 0-3.3 VAC. D7 limits the maximum voltage to 3.3V. C24, along with R22, R23 and R25, form a low-pass filter. The circuit is shown in Appendix A. “Board Layout and Schematics”.

• Amplification: The operational amplifier, MCP6024 (U13B), amplifies the conditioned AC input voltage; R45, R46, R47, R48, R49 and R51 set the gain. The MC6024 also shifts the conditioned AC input voltage to a 1.65V DC level. Therefore, the voltage applied to the dsPIC® DSC ADC channel varies within 0V to 3.3V. The offset is controlled by R50, R53 and R54. R39 and C39 filter out the high-frequency noise.

An AC input voltage, zero-crossing event is sensed using a voltage divider (R2-R5) and two optocouplers (U1 and U2). The circuit is shown in Appendix A. “Board Layout and Schematics”.

Rectified input current is measured using the shunt resistor, R34, and the operational amplifier, MCP6024 (U13A); R38, R39, R40, R41, R42 and R43 set the gain. R43 shifts the voltage present at the shunt resistor to a 1.65V DC level. Therefore, the voltage applied to the dsPIC® DSC ADC channel varies within 0V to 3.3V. The offset is controlled by R43, R53 and R54. R44 and C37 filter out the high-frequency noise. The circuit is shown in Appendix A. “Board Layout and Schematics”.

The DC bus voltage is sensed at the power module stage. Please refer to Section 3.2.4 “Feedback Circuitry” for more information.
3.1.4 Power Supplies

The PFC Stage Board provides the 15V power supply required to fire the power module IGBTs. The 15V power supply is built using a low-power offline SMPS primary switcher. The switching frequency is fixed to 60 kHz; the feedback signal to the power supply is provided by the optocoupler. The output voltage is regulated at 15V with a maximum output current of 0.750A, with the resultant maximum power at 11.25W. The input voltage range for this power supply is from 90 VAC to 265 VAC.

The PFC stage board also provides the 3.3V to powering up the Microchip PIC MCU/dsPIC DSC devices, the isolation circuitry, the communication ports, the Starter Kit programmer, etc. It also generates the 3.3V for powering the analog circuits and the analog reference for the Analog-to-Digital Converter (ADC) module.

The 3.3V rail is created using a step-down regulator, which is attached to the 15V regulator. The maximum output current is 0.650A, thus the resultant maximum power is 2.145W.

The 3.3V rail required for the analog circuits, such as the current feedback and the Analog-to-Digital Converter, is generated by a decoupling circuitry attached to the 3.3V regulator.

3.1.5 Fault Circuitry

Given the development nature of the system, robust independent Fault protection is provided on the PFC stage board. Two different Fault categories are used to indicate a Fault to the Microchip PIC MCU/dsPIC DSC devices.

**DC Bus Overcurrent**: This Fault signal is generated when the maximum current limit of 13A is reached. The comparison of the threshold value and the actual current is done by comparator, U8. The threshold limit is set by R56 and R57. R69 is a shunt jumper resistor that can disconnect the overcurrent Fault to the Microchip PIC MCU/dsPIC DSC devices.

**DC Bus Overvoltage**: This Fault signal is generated when the maximum voltage limit on the DC bus rails is reached. The threshold value is set to 412V. The comparison of the threshold value and the actual DC bus voltage is done by comparator, U7. The threshold limit is set by R96, R60, R61 and R62. R66 is a shunt jumper resistor that can disconnect the overvoltage Fault to the Microchip PIC MCU/dsPIC DSC devices.

**Note**: Both comparators are of an open-drain type and need an external pull-up resistor. Both circuits share this pull-up resistor, creating an OR condition at the output.
3.1.6 Board Connectors

The PFC stage board has four tab fast-on connectors, one AC inlet and one 14-pin keyed connector for attaching a flat cable.

For the AC mains supply input, standard double-insulated, 3-core flex cable should be used with a minimum current rating of 10A (1 mm², 18 AWG). A computer power cable can be used. The recommended cable size is 1.0 mm² to 1.5 mm² (18 AWG to 16 AWG) and it should have a 600V rating. This cable should also be double-insulated or have a protective ground screen.

<table>
<thead>
<tr>
<th>Note 1:</th>
<th>The system is designed for Installation Category II. Therefore, the incoming mains cable should be wired into a standard non-locking, 2-pin in addition with an earth ground-type plug.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2:</td>
<td>The unit is designed to be connected to the AC mains supply via a standard non-locking plug. As the unit has no mains switch, this plug constitutes the means of disconnection from the supply. Therefore, the user must have unobstructed access to this plug during operation.</td>
</tr>
</tbody>
</table>

The tab fast-on connectors, AC_N and AC_L, provide the connections to the bridge rectifier, BR1. The recommended cable size is 18 AWG to 16 AWG or 1.0 mm² to 1.5 mm². It is also recommended that cables used for the power connections should be terminated with blue or red crimp terminals. If crimp terminals are not used, care should be taken to ensure that stray strands of wire do not short to adjacent terminals or the enclosure. If possible, all wires should be stripped and tinned with solder before connecting to the dsPICDEM™ MCHV-3 Development Board terminals.

The fast-on connectors, PFC_OUT “+” and PFC_OUT “-”, provide DC bus voltage to the power module stage. The recommended cable size is 18 AWG to 16 AWG or 1.0 mm² to 1.5 mm². It is also recommended that cables used for the power connections should be terminated with blue or red crimp terminals. If crimp terminals are not used, care should be taken to ensure that stray strands of wire do not short to adjacent terminals or the enclosure. If possible, all wires should be stripped and tinned with solder before connecting to the dsPICDEM™ MCHV-3 Development Board terminals.

| Note: | The user should only access the power terminals when the system is fully discharged (see the Safety Notice” section on page 5). |
The 14-pin keyed connector provides the signals and power supply rails from and to the power stage. These signals are shown in Table 3-1.

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3.3V, Digital Rail</td>
<td>Output</td>
</tr>
<tr>
<td>2</td>
<td>Fault (Overcurrent or Overvoltage Condition)</td>
<td>Output</td>
</tr>
<tr>
<td>3</td>
<td>3.3V, Analog Rail</td>
<td>Output</td>
</tr>
<tr>
<td>4</td>
<td>AC Input Voltage Feedback</td>
<td>Output</td>
</tr>
<tr>
<td>5</td>
<td>Ground, Analog Rail</td>
<td>Output</td>
</tr>
<tr>
<td>6</td>
<td>AC Input Current Feedback</td>
<td>Output</td>
</tr>
<tr>
<td>7</td>
<td>PFC Driver Enable</td>
<td>Output</td>
</tr>
<tr>
<td>8</td>
<td>VAC Zero-Crossing Signal</td>
<td>Output</td>
</tr>
<tr>
<td>9</td>
<td>Ground, Digital Rail</td>
<td>Output</td>
</tr>
<tr>
<td>10</td>
<td>PWM Signal for the PFC IGBT</td>
<td>Input</td>
</tr>
<tr>
<td>11</td>
<td>Ground, Digital Rail</td>
<td>Output</td>
</tr>
<tr>
<td>12</td>
<td>Not Connected</td>
<td>NC</td>
</tr>
<tr>
<td>13</td>
<td>15V</td>
<td>Output</td>
</tr>
<tr>
<td>14</td>
<td>Not Connected</td>
<td>NC</td>
</tr>
</tbody>
</table>
### 3.2 POWER MODULE STAGE

This board has two main functions: the first is to control the motor using a Microchip PIC MCU/dsPIC DSC device and a power module, and the associated feedback signals for each control algorithm; the second is to provide a safe method in which to interact with the user.

**Note:** The circuits for the hardware described in this section are shown in Appendix A. “Board Layout and Schematics”.

#### 3.2.1 Plug-In Module Configuration

Table 3-2 summarizes the pinout functionality of the PIM (U11).

**TABLE 3-2: dsPICDEM™ MCHV-3 PIM PINOUT FUNCTIONALITY**

<table>
<thead>
<tr>
<th>PIM Pin #</th>
<th>Signal Name</th>
<th>Pinout Description</th>
<th>Routed via Matrix Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DBG_LED1</td>
<td>Debug LED 1</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>VDD</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>PWM1H3</td>
<td>PWM Output – 3H</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>5</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>6</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>7</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>8</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>9</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>10</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>11</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>12</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>13</td>
<td>MCLR</td>
<td>Device Master Clear</td>
<td>No</td>
</tr>
<tr>
<td>14</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>15</td>
<td>VSS</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>16</td>
<td>VDD</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>17</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>18</td>
<td>FAULT</td>
<td>IBus Current Fault (active-low logic)</td>
<td>No</td>
</tr>
<tr>
<td>19</td>
<td>PFC_FLT</td>
<td>IPFC Fault (overvoltage or overcurrent)</td>
<td>No</td>
</tr>
<tr>
<td>20</td>
<td>PIM_INDEX/POT/V_M3</td>
<td>Hall Sensor/Current Sense/Voltage Feedback Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>21</td>
<td>PIM_QEB/IB/V_M2</td>
<td>Hall Sensor/Current Sense/Voltage Feedback Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>22</td>
<td>PIM_QEA/IA/V_M1</td>
<td>Hall Sensor/Current Sense/Voltage Feedback Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>23</td>
<td>PIM_IBUS/V BUS</td>
<td>DC Bus Voltage (downscaled)</td>
<td>Yes</td>
</tr>
<tr>
<td>24</td>
<td>PIM_IB/POT</td>
<td>AC Input Zero Cross/AC Input Voltage (downscaled)/Potentiometer</td>
<td>Yes</td>
</tr>
<tr>
<td>25</td>
<td>PIM_IA/IPFC</td>
<td>PFC Current (buffered)</td>
<td>Yes</td>
</tr>
<tr>
<td>26</td>
<td>PGC</td>
<td>Device Programming Clock Line</td>
<td>No</td>
</tr>
<tr>
<td>27</td>
<td>PGD</td>
<td>Device Programming Data Line</td>
<td>No</td>
</tr>
<tr>
<td>28</td>
<td>AVDD/2</td>
<td>Reference Voltage (half of AVDD voltage)</td>
<td>No</td>
</tr>
<tr>
<td>29</td>
<td>PIM_REC_NEUTR</td>
<td>Reconstructed Motor Neutral Line Voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>30</td>
<td>AVDD</td>
<td>Analog Supply</td>
<td>No</td>
</tr>
<tr>
<td>31</td>
<td>AVSS</td>
<td>Analog Supply</td>
<td>No</td>
</tr>
</tbody>
</table>
### TABLE 3-2: dsPICDEM™ MCHV-3 PIM PINOUT FUNCTIONALITY (CONTINUED)

<table>
<thead>
<tr>
<th>PIM Pin #</th>
<th>Signal Name</th>
<th>Pinout Description</th>
<th>Routed via Matrix Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>PIM_POT</td>
<td>Potentiometer Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>33</td>
<td>PIM_POT</td>
<td>Potentiometer Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>34</td>
<td>PIM_GEN2</td>
<td>General I/O</td>
<td>Yes</td>
</tr>
<tr>
<td>35</td>
<td>PIM_DC_BUS</td>
<td>DC Bus Voltage (downscaled)</td>
<td>Yes</td>
</tr>
<tr>
<td>36</td>
<td>Vss</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>37</td>
<td>Vdd</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>38</td>
<td>PIM_VAC_VOL2</td>
<td>AC Input Voltage (unbuffered)</td>
<td>Yes</td>
</tr>
<tr>
<td>39</td>
<td>PIM_IPFC_C_SHUNT</td>
<td>PFC Shunt Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>40</td>
<td>PIM_PFC_L</td>
<td>PFC Shunt Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>41</td>
<td>PIM_V_M1/POT</td>
<td>Hall Sensor/Current Sense/Voltage Feedback Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>42</td>
<td>PIM_V_M2</td>
<td>Hall Sensor/Current Sense/Voltage Feedback Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>43</td>
<td>PIM_V_M3/IBUS</td>
<td>Hall Sensor/Current Sense/Voltage Feedback Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>44</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>45</td>
<td>Vss</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>46</td>
<td>Vss</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>47</td>
<td>HB/QEB</td>
<td>Hall Sensor/QEI Input</td>
<td>No</td>
</tr>
<tr>
<td>48</td>
<td>HC/INDX</td>
<td>Hall Sensor/QEI Input</td>
<td>No</td>
</tr>
<tr>
<td>49</td>
<td>RX</td>
<td>UART Receive</td>
<td>No</td>
</tr>
<tr>
<td>50</td>
<td>TX</td>
<td>UART Transmit</td>
<td>No</td>
</tr>
<tr>
<td>51</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>52</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>53</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>54</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>55</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>56</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>57</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>58</td>
<td>PIM_FLT_OUT2</td>
<td>General I/O</td>
<td>Yes</td>
</tr>
<tr>
<td>59</td>
<td>PIM_FLT_OUT1</td>
<td>General I/O</td>
<td>Yes</td>
</tr>
<tr>
<td>60</td>
<td>DBG_LED2</td>
<td>Debug LED #2</td>
<td>No</td>
</tr>
<tr>
<td>61</td>
<td>HOME</td>
<td>Home Signal for QEI (test point only)</td>
<td>No</td>
</tr>
<tr>
<td>62</td>
<td>Vdd</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>63</td>
<td>OSCI</td>
<td>Crystal Oscillator In</td>
<td>No</td>
</tr>
<tr>
<td>64</td>
<td>OSCO</td>
<td>Crystal Oscillator Out</td>
<td>No</td>
</tr>
<tr>
<td>65</td>
<td>Vss</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>66</td>
<td>PIM_IBUS+</td>
<td>IBus Shunt Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>67</td>
<td>PIM_IBUS-</td>
<td>IBus Shunt Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>68</td>
<td>BTN</td>
<td>Push Button</td>
<td>No</td>
</tr>
<tr>
<td>69</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>70</td>
<td>RX</td>
<td>UART Receive</td>
<td>No</td>
</tr>
<tr>
<td>71</td>
<td>PIM_PFC_PWM</td>
<td>PFC PWM Output</td>
<td>Yes</td>
</tr>
<tr>
<td>72</td>
<td>HA/QEA</td>
<td>Hall Sensor/QEI Input</td>
<td>No</td>
</tr>
<tr>
<td>73</td>
<td>PIM_IB+</td>
<td>IB Shunt Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>PIM Pin #</td>
<td>Signal Name</td>
<td>Pinout Description</td>
<td>Routed via Matrix Board</td>
</tr>
<tr>
<td>----------</td>
<td>----------------------</td>
<td>--------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>74</td>
<td>PIM_IA+</td>
<td>IA Shunt Signal</td>
<td>Yes</td>
</tr>
<tr>
<td>75</td>
<td>Vss</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>76</td>
<td>HB/QEB</td>
<td>Hall Sensor/QEI Input</td>
<td>No</td>
</tr>
<tr>
<td>77</td>
<td>PIM_HALLC/INDEX/STP_PWM</td>
<td>Hall Sensor/QEI Input</td>
<td>Yes</td>
</tr>
<tr>
<td>78</td>
<td>PIM_PFC_PWM</td>
<td>PFC PWM Output</td>
<td>Yes</td>
</tr>
<tr>
<td>79</td>
<td>VACZX</td>
<td>AC Input Zero Cross</td>
<td>No</td>
</tr>
<tr>
<td>80</td>
<td>HA/QEA</td>
<td>Hall Sensor/QEI Input</td>
<td>No</td>
</tr>
<tr>
<td>81</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>82</td>
<td>PIM_GEN1</td>
<td>General I/O</td>
<td>Yes</td>
</tr>
<tr>
<td>83</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>84</td>
<td>TX</td>
<td>UART Transmit</td>
<td>No</td>
</tr>
<tr>
<td>85</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>86</td>
<td>VDD</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>87</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>88</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>89</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>90</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>91</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>92</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>93</td>
<td>PWM1L1</td>
<td>PWM Output – 1L</td>
<td>No</td>
</tr>
<tr>
<td>94</td>
<td>PWM1H1</td>
<td>PWM Output – 1H</td>
<td>No</td>
</tr>
<tr>
<td>95</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>96</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>97</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>98</td>
<td>PWM1L2</td>
<td>PWM Output – 2L</td>
<td>No</td>
</tr>
<tr>
<td>99</td>
<td>PWM1H2</td>
<td>PWM Output – 2H</td>
<td>No</td>
</tr>
<tr>
<td>100</td>
<td>PWM1L3</td>
<td>PWM Output – 3L</td>
<td>No</td>
</tr>
</tbody>
</table>
3.2.2 Power Supplies

The system default configuration is to get the 15V, 3.3V and 3.3V analog rail voltages from the PFC stage board. However, it is also possible to use an external 24V power supply to generate these voltages.

U19, C70, C73, C71 and C74 regulate the voltage applied to the system via J15 (28V max). The output of the regulator is connected to the system through R109. The circuit is shown in Appendix A. “Board Layout and Schematics”.

**Note:** It is the responsibility of the user to populate these components if an external power supply is used.

U18, C67, R110, C68, D16, D15, L3, R111, R112 and C75 regulate the 15V to create a 3.3V digital rail. This auxiliary 3.3V digital rail is applied to the system through R106. The circuit is shown in Appendix A. “Board Layout and Schematics”.

**Note:** It is the responsibility of the user to populate these components if an external power supply is used.

R114, R107, C69 and C72 form a decoupling circuit for generating a 3.3V rail for the analog circuitry, such as the ADC reference and the current feedback reference. This auxiliary 3.3V analog rail is applied to the system through R108.

**Note:** It is the responsibility of the user to populate these components if an external power supply is used.

3.2.3 Power Module

The three-phase inverter is embedded in a power module (U16). This power module contains:
- 600V/30A 3-phase IGBT inverter bridge
- Gate driver circuitry for each IGBT
- Three independent connections to the negative DC bus for current sensing
- Short-circuit protection circuitry
- Thermal shutdown
- Gate driver power supply undervoltage protection
- Gate driver power supply overvoltage protection
- Single grounded power supply
- Isolation of 2.5 kV per minute
- Maximum switching frequency: 20 kHz

The Microchip PIC MCU/dsPIC DSC devices provide the PWM signals to this power module in order to turn on/off the IGBT and therefore, apply power to the motor phases. R95 and R124 set the threshold limit for the overcurrent circuitry. If this voltage is greater than 0.5V (typical), a Fault signal is asserted and the low-side IGTBs are turned off. R94 and C53 form a low-pass RC filter that filters out the frequencies above 88.4 kHz.

C56 sets the Fault pulse duration; the value of C56 is given by the following equation: \[ C56 = 18.3E^{-6} \times 1.8E^{-3} \text{ seconds} \]. Therefore, the Fault pulse duration is 54 \( \mu \)s.

The power module Fault Output pin (VFO) is configured as an open-collector. R50 pulls up the Fault output to the analog 3.3V rail. R53 and C40 form a low-pass RC filter that filters out the frequencies above 53 kHz.

For more information about this power module, please refer to the manufacturer’s data sheet.
3.2.4 Feedback Circuitry

The power module stage provides three different methods to sense the motor position. These signals are also useful to determine the speed, torque, current consumption and applied voltage.

**Hall Sensors:** The Hall sensor circuitry is designed to attach open-collector configured sensors. It has a pull-up resistor at the Hall sensor inputs (R23, R24 and R25) and a voltage divider (R26-R29, R27-R30, R28-R31) in order to scale the input waveforms to the PIC MCU or dsPIC DSC logic levels. C25-C27 and R26-R28 form a low-pass RC filter for each Hall sensor signal.

**Phase Voltage Feedback:** For each phase, this circuitry is compounded by a voltage divider, a current limiter and a low-pass RC filter. R79, R84 and R92 scale the Phase M1 voltage in order to match the PIC MCU or dsPIC DSC logic levels. R85 limits the current going to the ADC pin (<6 mA). C51, R79 and R84 form the low-pass filter. The Phase M2 and M3 have the exact same circuitry as shown in the schematic.

**DC Bus Voltage Feedback:** This voltage feedback is compounded by a voltage divider and a low-pass RC filter. R75, R76 and R81 scale the DC bus voltage in order to match the PIC MCU or dsPIC DSC logic levels. C47, R75 and R76 form the low-pass filter.

**Inverter Leg Shunt Resistor Feedback:** A shunt resistor is located between the emitter of the low-side switches, M1 and M2, and the “-DC bus”. A simple differential amplifier circuit is used, as shown in Appendix A. “Board Layout and Schematics”.

The operation of the circuit used for the Phase M1 leg is described in the following paragraph.

The current is measured using the shunt resistor, R86, and the operational amplifier, MCP6024 (U13A); R32, R33, R34, R36 and R37 set the gain. R38 shifts the voltage present at the shunt resistor to a 1.65V DC level. Hence, the voltage applied to the PIC MCU or dsPIC DSC ADC channel varies within 0V to 3.3V. The offset is controlled by R59, R60, R38 and U13D. R35 and C34 filter out the high-frequency noise.

The same topology is used for the Phase M2.

**DC Bus Current Feedback:** A shunt resistor is located between the shunt resistors of side switches, M1 and M2, and the “-DC bus”. A simple differential amplifier circuit is used, as shown in the schematic. The operation of the circuit used for sensing the DC bus current is described in the following paragraph.

The current is sensed using the shunt resistor, R95, and the operational amplifier, MCP6024 (U13C); R49, R51, R52, R56 and R57 set the gain. R58 shifts the voltage present at the shunt resistor to a 1.65V DC level. Hence, the voltage applied to the PIC MCU or dsPIC DSC ADC channel varies within 0V to 3.3V. The offset is controlled by R59, R60, R58 and U13D. R54 and C42 filter out the high-frequency noise.

**Note:** It is possible to select any of these feedback signals using jumpers, J12, J13 and J14. Please refer to Section 3.2.9 “User Interfaces” for more information.
3.2.5 Matrix Board

The functions of the matrix board interface are to:
- Connect the appropriate signals to the correct pins on the PIM
- Disconnect signals and provide isolation on signal paths that are not being used in a particular hardware configuration

The matrix board header has two rows of pins. One row (Pin 1 to Pin 25) hosts signals from different signal sources, while the other (Pin 26 to Pin 50) hosts connections to the PIM. A block diagram describing the matrix board interface is shown in Figure 3-1.

**FIGURE 3-1: MATRIX BOARD BLOCK DIAGRAM**

![Matrix Board Block Diagram](image)

The dsPICDEM™ MCHV-3 Development Board uses discrete op amps (U13) to amplify the shunt resistor signals. Alternatively, some of the PIC MCU or dsPIC DSC devices include on-board op amps that can be used for this purpose. To accommodate these two basic configurations, the dsPICDEM™ MCHV-3 Development Board comes with two matrix boards.

The internal op amp configuration matrix board is used to configure the development board to use op amps that are internal to the PIC MCU or dsPIC DSC devices. This matrix board bypasses the current feedback circuitry on the Power Module Board and directly connects the shunt resistor signals to the appropriate pins of the PIM.

The External Op Amp Configuration Matrix Board is used to configure the development board to use the current feedback circuitry on the Power Module Board. This matrix board disconnects the shunt resistor signals from the Plug-In Module pins and connects the current feedback circuitry output to the appropriate Plug-In Module pins.

The PFC – External Op Amp Configuration Matrix Board is used for configuring the development board to use the current feedback circuitry on the Power Module Board and current/voltage feedback circuitry on the PFC board. This matrix board disconnects the shunt resistor signals from the Plug-In Module pins and connects the current feedback circuitry output to the appropriate Plug-In Module pins. In addition, it also connects the PFC input AC current and PFC input AC voltage signals.

**Note:** Unless specified in the Plug-In Module information sheet, all PIMs are compatible only with the External Op Amp Configuration Matrix Board. Certain PIMs are designed to work with the Internal Op Amp Configuration Matrix Boards only. In this case, the corresponding PIM information sheet and/or Readme file within the source code folder (available at www.microchip.com/pims) will explicitly state this. Using any combination (Development Board + PIM + Matrix Board) other than that mentioned in the Readme file placed in the source code may lead to unexpected operation.
3.2.6 Fault Circuitry

In addition to the Fault signal generated by the power module, the system can also create a DC bus overcurrent Fault.

**DC Bus Overcurrent:** This Fault signal is generated when the maximum current limit of 15A is reached. The comparison of the threshold value and the actual current is done by comparator, U14. The threshold limit is set by R42 and R47.

```
Note: The comparator is open-drained and needs an external pull-up resistor.
Both the power module output and the comparator output share this pull-up resistor, creating an OR condition at the output.
```

3.2.7 Isolation

The power supply used by the push buttons, communication ports and the Starter Kit on-board programmer/debugger is isolated from the power supply used by the power module or the Microchip PIC MCU/dsPIC DSC devices. An isolated 3.3V rail is generated from the digital 3.3V rail using a DC-to-DC Converter (U10). This converter provides galvanic isolation, rated up to 1000 Vdc/1 second.

3.2.8 Communication Ports

The Power Module Stage Board provides two methods for transmitting/receiving data to and from the system. Both communication methods are powered using the isolated 3.3V rail.

**UART-to-USB:** This communication port is based on a PIC18LFJ2450 device with a serial emulator firmware. This device translates the USB signals to the Microchip PIC MCU/dsPIC DSC UART compatible signals. Isolation for the UART-to-USB communication port is provided by U25.

**UART-to-RS-232:** This communication port is based on a RS-232 transceiver (U9). This device translates the PIC MCU/dsPIC DSC UART signals to UART compatible signals. Isolation for the UART-to-RS-232 communication port is provided by U25.

Shunt jumpers, J2 and J3, select the communication port. Table 3-3 shows the possible configurations.

### TABLE 3-3: COMMUNICATION PORT CONFIGURATION

<table>
<thead>
<tr>
<th>Designator</th>
<th>Position</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J2</td>
<td>1-2</td>
<td>Connects UART Receive Line to RX.</td>
</tr>
<tr>
<td></td>
<td>2-3</td>
<td>Connects USB Receive Line to RX.</td>
</tr>
<tr>
<td>J3</td>
<td>1-2</td>
<td>Connects UART Transmit Line to TX.</td>
</tr>
<tr>
<td></td>
<td>2-3</td>
<td>Connects USB Transmit Line to TX.</td>
</tr>
</tbody>
</table>

Note: The comparator is open-drained and needs an external pull-up resistor. Both the power module output and the comparator output share this pull-up resistor, creating an OR condition at the output.
3.2.9 User Interfaces

There are two types of user interfaces, isolated and non-isolated.

- **Isolated Interfaces:**
  - Potentiometer labeled “POT” (R14)
  - RESET Push Button
  - PUSH BUTTON (S1)
  - PWM OUTPUT Enable Shunt Jumper (J7)
  - Communication Port Selection Shunt Jumper (J2 and J3)
  - ICSP™ Programmer/Debugger Connector for the Starter Kit on the Board (J4)
  - ICSP Programmer/Debugger Connector for the UART-to-USB Converter (J1)

- **Non-Isolated Interfaces:**
  - 15V Power Supply LED (D17)
  - 3.3V Power Supply LED (D18)
  - PWM2L1, PWM1L1, PWM1H1, PWM1L2, PWM1H2, PWM1L3, PWM1H3 LEDs
  - USB Communication LED (D1)
  - USB Cable Connected LED (D3)
  - Starter Kit On-Board USB Cable Connected LED (D21)
  - Starter Kit On-Board Power-on LED (D19)
  - ICSP Programmer/Debugger Connector for the PIC MCU or dsPIC DSC (J18)
  - Feedback Selection Shunt Jumpers, J11, J12, J13 and J14
  - Debug LEDs (D2 and D19)

Table 3-4 shows the multiple feedback signals that can be selected.

<table>
<thead>
<tr>
<th>Designator</th>
<th>Position</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J11</td>
<td>1-2</td>
<td>Connects AC Input Voltage Zero-Crossing Event to VACZX_VAC_POT</td>
</tr>
<tr>
<td></td>
<td>3-4</td>
<td>Connects AC Input Voltage to VACZX_VAC_POT</td>
</tr>
<tr>
<td></td>
<td>5-6</td>
<td>Connects the POT Voltage to VACZX_VAC_POT</td>
</tr>
<tr>
<td>J12</td>
<td>1-2</td>
<td>Connects Phase M1 Shunt Current Feedback to MONITOR_1</td>
</tr>
<tr>
<td></td>
<td>3-4</td>
<td>Connects Phase M1 Voltage Feedback to MONITOR_1</td>
</tr>
<tr>
<td></td>
<td>5-6</td>
<td>Connects Hall A/QEA Sensor Signal to MONITOR_1</td>
</tr>
<tr>
<td>J13</td>
<td>1-2</td>
<td>Connects Phase M2 Shunt Current Feedback to MONITOR_2</td>
</tr>
<tr>
<td></td>
<td>3-4</td>
<td>Connects Phase M2 Voltage Feedback to MONITOR_2</td>
</tr>
<tr>
<td></td>
<td>5-6</td>
<td>Connects Hall B/QEB Sensor Signal to MONITOR_2</td>
</tr>
<tr>
<td>J14</td>
<td>1-2</td>
<td>Connects DC Bus Shunt Current Feedback to MONITOR_3</td>
</tr>
<tr>
<td></td>
<td>3-4</td>
<td>Connects Phase M3 Voltage Feedback to MONITOR_3</td>
</tr>
<tr>
<td></td>
<td>5-6</td>
<td>Connects Hall C/INDEX Sensor Signal to MONITOR_3</td>
</tr>
<tr>
<td></td>
<td>7-8</td>
<td>Connects the POT Voltage to MONITOR_3</td>
</tr>
</tbody>
</table>
3.2.10 Hardware for Programming and Debugging

The dsPICDEM™ MCHV-3 Development Board, with its built-in Starter Kit on-board debugger/programmer, provides an all-in-one solution for debugging and programming applications using MPLAB IDE. The debugging/programming operations are controlled by a PIC24FJ256GB106 MCU. The PIC24FJ256GB106 device’s built-in USB engine provides the communication interface between the Starter Kit on the board and the host PC.

Power to the Starter Kit on the board is provided via the isolated 3.3V rail. The PIC24FJ256GB106 MCU accomplishes debugging or programming of the target PIC MCU or dsPIC DSC by controlling the target’s MCLR, PGC1/EMUC1 and PGD1/EMUD1 signals. A Microchip 25LC256 serial EEPROM is used to store the serial number and debug control information. Isolation for the MCLR, PGC1/EMUC1 and PGD1/EMUD1 signals is provided by the digital isolators, U3, U6, U22 and U7.

3.2.11 Board Connectors

Figure 3-2 provides the locations of the connectors. The Power Module Stage Board connectors are listed in Table 3-4.
The 14-pin keyed connector provides the signals, and power supply rails, from and to the Power Module Stage Board. These signals are shown in Table 3-6.

### TABLE 3-5: POWER MODULE STAGE BOARD CONNECTORS

<table>
<thead>
<tr>
<th>Number</th>
<th>Designator</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Motor Phase 1 (M1)</td>
<td>Output/Power</td>
</tr>
<tr>
<td>2</td>
<td>Motor Phase 2 (M2)</td>
<td>Output/Power</td>
</tr>
<tr>
<td>3</td>
<td>Motor Phase 3 (M3)</td>
<td>Output/Power</td>
</tr>
<tr>
<td>4</td>
<td>DC Bus “+”</td>
<td>Input/Power</td>
</tr>
<tr>
<td>5</td>
<td>DC Bus “-”</td>
<td>Input/Power</td>
</tr>
<tr>
<td>6</td>
<td>Hall Sensor A (HA)</td>
<td>Input</td>
</tr>
<tr>
<td>7</td>
<td>Hall Sensor B (HB)</td>
<td>Input</td>
</tr>
<tr>
<td>8</td>
<td>Hall Sensor C (HC)</td>
<td>Input</td>
</tr>
<tr>
<td>9</td>
<td>Hall Sensors, 5V Power Supply Terminal</td>
<td>Output/Power</td>
</tr>
<tr>
<td>10</td>
<td>Hall Sensors, Ground Terminal</td>
<td>Output/Power</td>
</tr>
<tr>
<td>11</td>
<td>UART-to-USB Connector</td>
<td>Input/Output</td>
</tr>
<tr>
<td>12</td>
<td>UART-to-RS-232 Connector</td>
<td>Input/Output</td>
</tr>
<tr>
<td>13</td>
<td>USB Connector for the Starter Kit Programmer/Debugger</td>
<td>Input/Output</td>
</tr>
<tr>
<td>14</td>
<td>Connector for Matrix Board (J4)</td>
<td>Input/Output</td>
</tr>
<tr>
<td>15</td>
<td>Isolated ICSP™ Programmer/Debugger Connector for UART-to-USB Converter (J1)</td>
<td>Input/Output</td>
</tr>
<tr>
<td>16</td>
<td>ICSP Programmer/Debugger Connector for PIC® MCU or dsPIC® DSC (J18)</td>
<td>Input/Output</td>
</tr>
<tr>
<td>17</td>
<td>14-Pin Keyed Connector (J16)</td>
<td>Input/Output/Power</td>
</tr>
</tbody>
</table>

### TABLE 3-6: 14-PIN KEYED CONNECTORS

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3.3V, Digital Rail</td>
<td>Output</td>
</tr>
<tr>
<td>2</td>
<td>AC Input Voltage Feedback (not buffered)</td>
<td>Output</td>
</tr>
<tr>
<td>3</td>
<td>3.3V, Analog Rail</td>
<td>Output</td>
</tr>
<tr>
<td>4</td>
<td>AC Input Voltage Feedback (buffered)</td>
<td>Output</td>
</tr>
<tr>
<td>5</td>
<td>Ground, Analog Rail</td>
<td>Output</td>
</tr>
<tr>
<td>6</td>
<td>AC Input Current Feedback</td>
<td>Output</td>
</tr>
<tr>
<td>7</td>
<td>Fault (overcurrent or overvoltage condition)</td>
<td>Output</td>
</tr>
<tr>
<td>8</td>
<td>VAC Zero-Crossing Signal</td>
<td>Output</td>
</tr>
<tr>
<td>9</td>
<td>PFC Shunt Signal</td>
<td>Output</td>
</tr>
<tr>
<td>10</td>
<td>PWM Signal for the PFC IGBT</td>
<td>Input</td>
</tr>
<tr>
<td>11</td>
<td>Ground, Digital Rail</td>
<td>Output</td>
</tr>
<tr>
<td>12</td>
<td>PWM Fault</td>
<td>Output</td>
</tr>
<tr>
<td>13</td>
<td>15V</td>
<td>Output</td>
</tr>
<tr>
<td>14</td>
<td>PFC Shunt Signal</td>
<td>Output</td>
</tr>
</tbody>
</table>
3.3 ELECTRICAL SPECIFICATIONS

The maximum power and current capability of the system is dictated by the allowable temperature rise of the different components. Establishing maximum limits is not simple, given the different ways the user may use the system. The voltage and the nature of the electrical load used, both affect the dissipation that occurs. In determining the allowable limits for the power semiconductors, the following assumptions have been made:

- Heat sink is at 70°C (worst case)
- Thermal resistance of the insulating thermal pad is 3°C/W

**TABLE 3-7: INVERTER ELECTRICAL SPECIFICATIONS**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC Bus</td>
<td>40</td>
<td>310</td>
<td>400</td>
<td>Vdc</td>
</tr>
<tr>
<td>Current</td>
<td>0.1</td>
<td>6.5</td>
<td>10</td>
<td>A</td>
</tr>
<tr>
<td>Power Rating</td>
<td>4</td>
<td>2015</td>
<td>4000</td>
<td>Watts</td>
</tr>
<tr>
<td>Switching Frequency</td>
<td>0</td>
<td>—</td>
<td>20</td>
<td>kHz</td>
</tr>
</tbody>
</table>

**Note 1:** The system is continuously operated during one hour; 15 kHz switching frequency and the PFC boost circuit are disabled.

**Note 2:** It is possible to increase the available maximum output power, up to 4000W, by using an external ventilation mechanism attached to the system near to the power module. To provide additional air flow, a conventional AC muffin fan can be used (Comair-rotron Part Number 028021 or 028023). An alternative bonded fin heat sink with fans attached is also an option (C&H Technology, Inc. Part Number CH5117F).

**TABLE 3-8: PFC ELECTRICAL SPECIFICATIONS**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC Bus</td>
<td>90</td>
<td>380</td>
<td>400</td>
<td>Vdc</td>
</tr>
<tr>
<td>Current</td>
<td>0.1</td>
<td>2.1</td>
<td>2.5</td>
<td>A</td>
</tr>
<tr>
<td>Power Rating</td>
<td>9</td>
<td>800</td>
<td>1000</td>
<td>Watts</td>
</tr>
<tr>
<td>Switching Frequency</td>
<td>0</td>
<td>50</td>
<td>100</td>
<td>kHz</td>
</tr>
</tbody>
</table>

**Note 1:** The system continuously operated during one hour; 50 kHz switching frequency.

**Note 2:** It is possible to increase the available maximum output power, up to 1000W, by using an external ventilation mechanism attached to the system near to the PFC IGBT. To provide additional air flow, a conventional AC muffin fan can be used (Comair-rotron Part Number 028021 or 028023). An alternative bonded fin heat sink with fans attached is also an option (C&H Technology, Inc. Part Number CH5117F).
Appendix A. Board Layout and Schematics

A.1 INTRODUCTION

This chapter provides detailed technical information on dsPICDEM™ MCHV-3 Development Board.

A.2 BOARD SCHEMATICS AND LAYOUT

The following schematics and layout diagrams provided detailed information about the board:

- **Figure A-1** – PFC Stage Board Layout (Top)
- **Figure A-2** – PFC Stage Schematic (Sheet 1 of 3)
- **Figure A-3** – PFC Stage Schematic (Sheet 2 of 3)
- **Figure A-4** – PFC Stage Schematic (Sheet 3 of 3)
- **Figure A-5** – Power Module Stage Board Layout (Top)
- **Figure A-6** – Power Module Stage Board Layout (Bottom)
- **Figure A-7** – Power Module Stage Schematic (Sheet 1 of 6)
- **Figure A-8** – Power Module Stage Schematic (Sheet 2 of 6)
- **Figure A-9** – Power Module Stage Schematic (Sheet 3 of 6)
- **Figure A-10** – Power Module Stage Schematic (Sheet 4 of 6)
- **Figure A-11** – Power Module Stage Schematic (Sheet 5 of 6)
- **Figure A-12** – Power Module Stage Schematic (Sheet 6 of 6)
- **Figure A-13** – Internal Op Amp Configuration Matrix Board Schematic
- **Figure A-14** – External Op Amp Configuration Matrix Board Schematic
- **Figure A-15** – PFC – External Op Amp Configuration Board Schematic
FIGURE A-1: PFC STAGE BOARD LAYOUT (TOP)
FIGURE A-5: POWER MODULE STAGE BOARD LAYOUT (TOP)
FIGURE A-12: POWER MODULE STAGE SCHEMATIC (SHEET 6 OF 6)
FIGURE A-13: INTERNAL OP AMP CONFIGURATION MATRIX BOARD SCHEMATIC

| IBus_SHUNT+ | 1 | PIM_IBus+ |
| IBus_SHUNT- | 2 | PIM_IBus- |
| IA_SHUNT+  | 3 | PIM_IA+ |
| IB_SHUNT+  | 4 | PIM_IB+ |
| VAC_VOL2   | 5 | X | 46 | PIM_VAC_VOL2 |
| IPFC_C_SHUNT | 6 | X | 45 | PIM_IPFC_C_SHUNT |
| PFC_L      | 7 | X | 44 | PIM_PFC_L |
| REC_NEUTR  | 8 | X | 43 | PIM_REC_NEUTR |
| MONITOR_1  | 9 | X | 42 | PIM_V_M1/POT |
| MONITOR_2  | 10 | X | 41 | PIM_V_M2 |
| MONITOR_3  | 11 | X | 40 | PIM_V_M3/IBus |
| VBus       | 12 | X | 39 | PIM_DC_BUS |
| VBus/IBus  | 13 | X | 38 | PIM_IBus/VBus |
| IPFC/A     | 14 | X | 37 | PIM_IA/IPFC |
| VACX_VAC_POT/IB | 15 | X | 36 | PIM_IB/POT |
| POT        | 16 | X | 35 | PIM_POT |
| FAULT_IP/IBus | 17 | X | 34 | PIMFLT_OUT1 |
|            | 18 | X | 33 | PIMFLT_OUT2 |
| PWM2L1     | 19 | X | 32 | PIM_PFC_PWM |
| HC/INDX    | 20 | X | 31 | PIM_HALLC/INDX/STP_PWM |
|            | 21 | X | 30 | PIM_GEN1 |
|            | 22 | X | 29 | PIM_GEN2 |
| V_M1       | 23 | X | 28 | PIM_QEA/IA/V_M1 |
| V_M2       | 24 | X | 27 | PIM_QEB/IB/V_M2 |
| V_M3       | 25 | X | 26 | PIM_INDEX/POI/V_M3 |
FIGURE A-14: EXTERNAL OP AMP CONFIGURATION MATRIX BOARD SCHEMATIC

| IBus_SHUNT+ | 1 | PIM_IBus+ |
| IBus_SHUNT- | 2 | PIM_IBus- |
| IA_SHUNT+  | 3 | PIM_JA+  |
| IB_SHUNT+  | 4 | PIM_IB+  |
| VAC_VOL2   | 5 | PIM_VAC_VOL2 |
| IPFC_C_SHUNT | 6 | PIM_IPFC_C_SHUNT |
| PFC_L      | 7 | PIM_PFC_L |
| REC_NEUTR  | 8 | PIM_REC_NEUTR |
| MONITOR_1  | 9 | PIM_V_M1/POT |
| MONITOR_2  | 10 | PIM_V_M2 |
| MONITOR_3  | 11 | PIM_V_M3/IBus |
| VBus       | 12 | PIM_DC_BUS |
| VBUS/IBus  | 13 | PIM_IBus/VBus |
| IPFC/IA    | 14 | PIM_JA/IPFC |
| VACZX_VAC_POT/IB | 15 | PIM_IB/POT |
| POT        | 16 | PIM_POT |
| FAULT_IB/IBus | 17 | PIM_FLT_OUT1 |
| PWM2L1     | 18 | PIM_FLT_OUT2 |
| HC/INDEX   | 19 | PIM_PFC_PWM |
| V_M1       | 20 | PIM_HALLC/INDEX/STP_PWM |
| V_M2       | 21 | PIM_GEN1 |
| V_M3       | 22 | PIM_GEN2 |
|           | 23 | PIM_QEA/IA/V_M1 |
|           | 24 | PIM_QEB/IB/V_M2 |
|           | 25 | PIM_INDEX/POT/V_M3 |
FIGURE A-15: PFC – EXT OP AMP CONFIGURATION BOARD SCHEMATIC
# Index

## A
- Application Debugging ............................................. 29
- Running in Debug Mode ................................... 28
- Application Programming ......................................... 30

## B
- Block Diagrams
  - dsPICDEM MCHV-3 Development Board System ............. 17
- Matrix Board ..................................................... 42
- Board Components .................................................. 19
- PFC Stage ........................................................ 19
- Power Module Stage ........................................ 19
- Board Layout and Schematics .................................... 49

## C
- Communication Ports ............................................... 43
- Connecting the System
  - Communication Port Connectors ...................... 24
  - Connections ...................................................... 23
  - Power Connections ........................................... 22
  - Power Connections (table) ............................... 23
  - Sequence .......................................................... 24
- Customer Change Notification Service .................... 12
- Customer Support .................................................... 13

## D
- Device Support and Reserved Resources ........................ 30
- Documentation
  - Conventions ...................................................... 10
  - Layout ................................................................. 9
- dsPICDEM™ MCHV-3 Development Board
  - Features ............................................................ 18
    - Additional Protection Circuitry ...................... 18
    - Built-in Isolated Programmer/Debugger .......... 18
    - Built-in Power Supplies ............................... 18
    - Input/Output .................................................... 18
    - Isolated Communication Ports ...................... 18
    - Motor Control Interfaces ............................. 18
    - Power Factor Corrector ............................... 18
    - Relay Circuit .................................................. 18
  - Layout and Schematics .................................... 49
  - Overview ........................................................... 15

## E
- Electrical Specifications ........................................... 47
- Inverter ............................................................. 47
- PFC ................................................................. 47

## F
- Fault Circuitry
  - DC Bus Overcurrent ........................................ 43
  - Feedback Circuitry ............................................ 41
  - DC Bus Current Feedback .................................. 41
  - DC Bus Voltage Feedback .................................. 41
  - Hall Sensors .................................................... 41
  - Inverter Leg Shunt Resistor Feedback ................ 41
  - Phase Voltage Feedback .................................... 41

## H
- Hardware
  - Programming and Debugging ................................ 45
  - Hardware Components ........................................... 31

## I
- Interface Components .............................................. 20
  - Built-in Isolated Programmer/Debugger ............ 20
  - Input/Output Control Switches ........................ 20
  - Isolated Communication Ports .......................... 20
  - Motor Connectors ............................................. 20
  - Power Supply Connector .................................. 20
  - PWM Outputs .................................................... 20
  - Internet Address ................................................. 12
  - Isolation ............................................................. 43

## M
- Matrix Board ............................................................. 42
- Microchip Internet Web Site ..................................... 12

## P
- PFC Stage Board ..................................................... 31
  - AC Supply Input ............................................... 31
  - Active Correction ............................................. 32
  - Connectors ....................................................... 35
  - Fault Circuitry .................................................. 34
  - Feedback Circuitry ............................................ 33
  - Power Supplies .................................................. 34
  - Power Module Stage
    - Module ........................................................... 40
    - PIM Configuration ............................................ 37
    - Power Supplies .................................................. 40
  - Power Module Stage Board
    - Connectors ..................................................... 45
  - Power Sequences
    - Application Debug Setup .................................. 26
    - Power-Down ...................................................... 26
    - Power-up .......................................................... 26
    - Programming and Debugging ............................ 26
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reading, Recommended</td>
<td>11</td>
</tr>
<tr>
<td>Revision History</td>
<td>13</td>
</tr>
<tr>
<td>Safety Notice</td>
<td>5</td>
</tr>
<tr>
<td>Sales and Service</td>
<td>67</td>
</tr>
<tr>
<td>Starter Kit</td>
<td></td>
</tr>
<tr>
<td>On-Board Information Tab</td>
<td>30</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td></td>
</tr>
<tr>
<td>Debug Connection Problems</td>
<td>30</td>
</tr>
<tr>
<td>Programming Problems</td>
<td>30</td>
</tr>
<tr>
<td>User Interfaces</td>
<td>44</td>
</tr>
<tr>
<td>Warranty Registration</td>
<td>11</td>
</tr>
<tr>
<td>Worldwide Sales and Service</td>
<td>67</td>
</tr>
<tr>
<td>WWW Address</td>
<td>12</td>
</tr>
</tbody>
</table>
# Worldwide Sales and Service

## AMERICAS

**Corporate Office**
2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200
Fax: 480-792-7277
Technical Support: [http://www.microchip.com/support](http://www.microchip.com/support)
Web Address: [www.microchip.com](http://www.microchip.com)

**Atlanta**
Duluth, GA
Tel: 678-957-9614
Fax: 678-957-1455

**Austin, TX**
Tel: 512-257-3370

**Boston**
Westborough, MA
Tel: 774-760-0087
Fax: 774-760-0088

**Chicago**
Itasca, IL
Tel: 630-285-0071
Fax: 630-285-0075

**Cleveland**
Independence, OH
Tel: 216-447-0464
Fax: 216-447-0643

**Dallas**
Addison, TX
Tel: 972-818-7423
Fax: 972-818-2924

**Detroit**
Novi, MI
Tel: 888-374-9607
Fax: 888-374-9608

**Houston, TX**
Tel: 281-894-5983

**Indianapolis**
Noblesville, IN
Tel: 317-773-8323
Fax: 317-773-5453

**Los Angeles**
Mission Viejo, CA
Tel: 949-462-9523
Fax: 949-462-9608

**New York, NY**
Tel: 631-435-6000

**San Jose, CA**
Tel: 408-735-9110

**Canada - Toronto**
Tel: 905-673-0699
Fax: 905-673-6509

## ASIA/PACIFIC

**Asia Pacific Office**
Suites 3707-14, 37th Floor
Tower 6, The Gateway Harbour City, Kowloon

**Hong Kong**
Tel: 852-2943-5100
Fax: 852-2401-3431

**Australia - Sydney**
Tel: 61-2-9868-6733
Fax: 61-2-9868-6755

**China - Beijing**
Tel: 86-10-8569-7000
Fax: 86-10-8528-2104

**China - Chengdu**
Tel: 86-28-8665-5511
Fax: 86-28-8665-7889

**China - Dongguan**
Tel: 86-769-8702-9880

**China - Hangzhou**
Tel: 86-571-8792-8115
Fax: 86-571-8792-8116

**China - Hong Kong SAR**
Tel: 852-2943-5100
Fax: 852-2401-3431

**China - Nanjing**
Tel: 86-25-8473-2460
Fax: 86-25-8473-2470

**China - Shanghai**
Tel: 86-21-5407-5533
Fax: 86-21-5407-5066

**China - Shenyang**
Tel: 86-24-2334-2829
Fax: 86-24-2334-2393

**China - Shenzhen**
Tel: 86-755-8867-2200
Fax: 86-755-8203-1760

**China - Shenzhen**
Tel: 86-755-8867-2200
Fax: 86-755-8203-1760

**China - Xian**
Tel: 86-29-8833-7252
Fax: 86-29-8833-7256

**India - Bangalore**
Tel: 91-80-3090-4444
Fax: 91-80-3090-4444

**India - New Delhi**
Tel: 91-11-4160-8631
Fax: 91-11-4160-8632

**Japan - Osaka**
Tel: 81-6-6152-7160
Fax: 81-6-6152-9310

**Japan - Tokyo**
Tel: 81-3-6880-3770
Fax: 81-3-6880-3771

**Korea - Daegu**
Tel: 82-53-744-4301
Fax: 82-53-744-4302

**Korea - Seoul**
Tel: 82-2-554-7200
Fax: 82-2-558-5932

**Malaysia - Kuala Lumpur**
Tel: 60-3-6201-9857
Fax: 60-3-6201-9859

**Malaysia - Penang**
Tel: 60-4-227-8870
Fax: 60-4-227-4068

**Philippines - Manila**
Tel: 63-2-634-9065
Fax: 63-2-634-9069

**Singapore**
Tel: 65-6334-8870
Fax: 65-6334-8850

**Taiwan - Hsin Chu**
Tel: 886-3-5778-366
Fax: 886-3-5770-955

**Taiwan - Kaohsiung**
Tel: 886-7-213-7828

**Taiwan - Taipei**
Tel: 886-2-2508-8600
Fax: 886-2-2508-0102

**Thailand - Bangkok**
Tel: 66-2-694-1351
Fax: 66-2-694-1350

## EUROPE

**Austria - Wels**
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393

**Denmark - Copenhagen**
Tel: 45-4450-2826
Fax: 45-4485-2829

**France - Paris**
Tel: 33-1-69-53-63-20
Fax: 33-1-69-30-90-79

**Germany - Dusseldorf**
Tel: 49-2129-3766400

**Germany - Karlsruhe**
Tel: 49-721-625370

**Germany - Munich**
Tel: 49-89-627-144-0
Fax: 49-89-627-144-44

**Italy - Milan**
Tel: 39-0331-742611
Fax: 39-0331-466781

**Italy - Venice**
Tel: 39-049-7625286

**Netherlands - Drunen**
Tel: 31-416-690399
Fax: 31-416-690340

**Poland - Warsaw**
Tel: 48-22-3325737

**Spain - Madrid**
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91

**Sweden - Stockholm**
Tel: 46-8-5090-4654

**UK - Wokingham**
Tel: 44-118-921-5800
Fax: 44-118-921-5820

07/14/15